
 

 

 

 

 

 

 

 

 

 

 

 

 

Kroll Version 10 
Service Pack 35 

Feature Release Notes 
 

 

March 2026



Kroll V10 SP35 Feature Release Notes  2 

Table of contents 

Kroll Version 10 Service Pack 35 Feature Release Notes ...................................................................................................................................... 6 

Adaptation ......................................................................................................................................................................................................................................... 6 
[KRL-20341] Update existing Rx Adaptation screen to fully support Quebec regulations ...................................................... 6 

Adjudication ...................................................................................................................................................................................................................................... 7 
[KRL-20431] Mapping of FFS Submission Codes for Rx Adaptations in Quebec (via RAMQ) .............................................. 7 

API .......................................................................................................................................................................................................................................................... 7 
[KRL-15741] eMAR API Consent Management ................................................................................................................................................. 7 
[KRL-21002] Privacy Controls for eMAR Prescription Sharing ............................................................................................................. 10 
[KRL-20021] Enhanced eMAR Barcode Integration for Packaging Reports .................................................................................. 11 

Auto-Refill Consent ..................................................................................................................................................................................................................... 11 
[KRL-18498] Add new Auto-Refill consent type ............................................................................................................................................. 11 
[KRL-18496] Auto-Refill consent configuration ............................................................................................................................................... 11 
[KRL-18499] Auto-Refill Consent modal trigger (Enhanced RxSync workflow) ......................................................................... 12 
[KRL-18500] Auto-Refill Consent modal trigger (Other Kroll triggered Auto-Refill workflows) ........................................ 13 
[KRL-18497] Auto-Refill consent questionnaire schema (Default TELUS version) .................................................................... 14 
[KRL-18502]  Auto-Refill Consent Report support ........................................................................................................................................ 14 

Enhanced RxSync ....................................................................................................................................................................................................................... 15 
[KRL-16776] Moving Store-Level Configurations for RxSync to its own Tab ................................................................................ 15 
[KRL-16775] Kroll-Level Configuration for RxSync ....................................................................................................................................... 16 
[KRL-17238] Pre-qualification logic and Store-level configuration for Enhanced RxSync .................................................... 17 
[KRL-16711] RxSync Options button and window .......................................................................................................................................... 18 
[KRL-17710] RxSync-Only workflow ...................................................................................................................................................................... 19 
[KRL-17712] RxSync + Autofill workflow .............................................................................................................................................................. 21 
[KRL-18276] Post-Sync Program Management ............................................................................................................................................ 22 
[KRL-20450] Existing prescription management ......................................................................................................................................... 23 
[KRL-16713] RxSync: Post-Sync Logic for New prescriptions ............................................................................................................... 24 
[KRL-18341] Program Lifecycle Management (Pause/Stop/Restart) ............................................................................................... 24 
[KRL-17715] Program status reporting ................................................................................................................................................................ 25 
[KRL-16720] Reporting RxSync Status ............................................................................................................................................................... 25 

Kroll Care Plus powered by RxVigilance ....................................................................................................................................................................... 25 
[KRL-17497] RxvEngine | Support Vigilance's stand-alone Profile Analysis utility from the patient screen ................ 26 

Lab results ....................................................................................................................................................................................................................................... 27 
[KRL-18794] Add 'Lab Results' as a new document type on the scan screen .............................................................................. 27 



Kroll V10 SP35 Feature Release Notes  3 

Labels ................................................................................................................................................................................................................................................. 28 
[KRL-18920] Update Drug Expiry Date details on the Vial label for Quebec ................................................................................. 28 

Language Support ..................................................................................................................................................................................................................... 29 
[KRL-17632] Search for and display allergies and conditions in the session’s language ....................................................... 29 
[KRL-17634] Provide the ability for users to easily launch a Kroll session in French or English ........................................... 31 
[KRL-17869] Allow Doctor Facing reports to print in doctor’s written language ......................................................................... 31 
[KRL-16998] Allow reports to print in doctor’s or patient’s default language (English or French) .................................... 32 
[KRL-20942] Standardize translation for “General Counseling” across all areas of Kroll application............................ 33 
[KRL-21862] F7 - Doctor translation ...................................................................................................................................................................... 33 

Operating System....................................................................................................................................................................................................................... 33 
[KRL-18711] Add an OS Check and Hard Stop for Unsupported Windows Version ................................................................. 33 

Patient Counselling .................................................................................................................................................................................................................... 34 
[KRL-19383] Add Patient filter to Counselling Items workflow queue ............................................................................................. 34 
[KRL-18474] Allow multiple counselling items to be actioned at the same time ......................................................................... 34 

Quebec RAMQ Pricing ............................................................................................................................................................................................................ 36 
[KRL-17011] Code Updates - RAMQ Special Plan codes .......................................................................................................................... 36 
[KRL-17012 & KRL-20223] RAMQ Fees Screen Enhancements and Service Code Description Updates ................. 37 
[KRL-17154] Adjustment to the Patient Plan Information Screen to make checkboxes more visible ............................. 38 
[KRL-17226, KRL-17227, KRL-17228, KRL-17229] Addition of support for encapsulated mixture pricing 

calculations .......................................................................................................................................................................................................................... 39 
[KRL-17230, KRL-20366, KRL-20484, KRL-20485] Quebec therapeutic adjustment billing support with 

enhanced Service code functionality for RAMQ ............................................................................................................................................. 41 
[KRL-17231] RAMQ service code and service type override capability in plan information screen ................................. 43 
[KRL-17678 & KRL-20763] RAMQ fee threshold configuration relocated to store-level settings ................................... 44 
[KRL-17679 & KRL-17969] Enhanced chronic medication service code selection for RAMQ billing with days 

supply evaluation .............................................................................................................................................................................................................. 45 
[KRL-18054] View patient's current RAMQ monthly contribution and maximum amount via a hover hint on the 

patient card .......................................................................................................................................................................................................................... 46 
[KRL-18441] RAMQ mixture proportion validation expanded to support Units measurement for specific service 

codes ....................................................................................................................................................................................................................................... 47 
[KRL-18442] Automatic service type L assignment for encapsulated mixtures billed under RAMQ special 

program code 40 ............................................................................................................................................................................................................. 49 
[KRL-18650] Decouple the usage of PDIN for the storage of Service Codes and Types ..................................................... 50 
[KRL-18869] Migration of PDIN Data to SSC Code and Type Fields for RAMQ .......................................................................... 51 
[KRL-18870] RAMQ Vaccination Service Code VA Workflow Simplification and Special Program Code 07 

Automation .......................................................................................................................................................................................................................... 52 



Kroll V10 SP35 Feature Release Notes  4 

[KRL-18901] RAMQ Product Selection Handling for "Prescriber's Choice" | INFOLETTRES-067 .................................. 53 
[KRL-18902] RAMQ Naloxone Program DIN Expansion and Service Code Label Update .................................................. 54 
[KRL-18903] RAMQ Opioid Treatment Service Code J Handling Enhancement ...................................................................... 55 
[KRL-19047] RAMQ Service Code Y Label Update and Special Program Code 07 Requirement Removal ............. 58 
[KRL-19048] RAMQ Service Code DC Validation and Special Program Code 07 Automation ........................................ 59 
[KRL-19049] RAMQ Service Code V Type Assignment and Validation Enhancement ......................................................... 59 
[KRL-19051] RAMQ Service Code F Label Update and Intervention Code Validation Enhancement ............................ 61 
[KRL-19052] RAMQ Service Code SP Special Program Code 07 and Prescription Type Validation ............................ 62 
[KRL-20085] RAMQ Service Code T Fee Calculation Base Rate Correction and Elastomeric Infuser Label 

Updates .................................................................................................................................................................................................................................. 63 
[KRL-20173] RAMQ Intervention Code Validation Standardization for Multiple Service Codes ...................................... 64 
[KRL-20175] RAMQ Service Code I Label Update for Insulin Syringe Preparation ................................................................... 65 
[KRL-20224] RAMQ Service Code CV Pandemic Services Removal .............................................................................................. 67 
[KRL-20299] RAMQ Service Code Prescription Type Validation for Written Prescription Requirement .................. 68 
[KRL-20486] RAMQ Service Code IU Automatic Assignment for Emergency Medication Administration .............. 70 
[KRL-20487] RAMQ Packaging and Transportation Billing Modules for Emergency and Exceptional 

Circumstances .................................................................................................................................................................................................................... 71 
[KRL-20840] Modification of a Drug Therapy (AD) ..................................................................................................................................... 73 
[KRL-20976] ] Extend Pricing strategy logic to support formulary determination for federal plans in Quebec. ..... 73 
[KRL-22151] Allow user to push addition Pill Pack fee to patient for service code G ............................................................... 74 

Rx Number ...................................................................................................................................................................................................................................... 74 
[KRL-19813] Changing a regular Rx number to a Narcotic Rx number when a Narcotic drug is filled ........................... 74 

RxConsult ........................................................................................................................................................................................................................................ 75 
[KRL-10004] Integrate Follow-ups entered in RxConsult and automatically add to Kroll after service finalized .... 75 
[KRL-15624]  Map Quebec-specific billing codes to FFS claims in Kroll when output message received from 

RxConsult .............................................................................................................................................................................................................................. 76 
[KRL-15710] Update Rx Adaptations to integrate with RxConsult in Quebec .............................................................................. 76 
[KRL-15742 ] Update Rx Extensions to integrate with RxConsult in Quebec ................................................................................ 78 
[KRL-15764] Update laboratory analysis to integrate with RxConsult in Quebec ...................................................................... 78 
[KRL-15784] Properly support languages for Patient sheets and content generated by RxConsult ............................. 79 
[KRL-15891] Update KCM to include AQPP Laboratory Analysis as a fee for service on the drug card ...................... 80 
[KRL-16740] Force follow-ups in RxConsult for Minor Ailments, Adaptations, Extensions, and Lab Analysis .......... 80 
[KRL-16825] Add Patient Configuration options to support Professional Services modules for RxConsult in 

Quebec ................................................................................................................................................................................................................................... 80 
[KRL-16860] Add Immunization Configuration option for RxConsult in Quebec ........................................................................ 81 
[KRL-20956] Allow new medication to be entered in RxConsult for Adaptations .................................................................... 82 



Kroll V10 SP35 Feature Release Notes  5 

RxSync Consent .......................................................................................................................................................................................................................... 83 
[KRL-16712] RxSync Consent Configurations ................................................................................................................................................. 83 
[KRL-18427] Update Patient Consent report to include Enhanced RxSync consent records ............................................ 84 
[KRL-18429] Add New Enhanced RxSync Consent type ......................................................................................................................... 84 
[KRL-18431] Integrate RxSync Consent with Document and Network Scan Queues ............................................................. 85 
[KRL-18723] Create RxSync Consent Questionnaire Schema (Default KCM Version) ........................................................... 85 

Provinces ......................................................................................................................................................................................................................................... 86 
Quebec ........................................................................................................................................................................................................................................ 86 

[KRL-20916] Kroll properly supports Management Stopped for prescription adaptations in Quebec ........................ 86 
Saskatchewan ......................................................................................................................................................................................................................... 86 

[KRL-18132] Implement selecting a Pharmacist Prescribe Reason for Regular, Compound, and Unfill Rxs that are 

part of a Batch filling process .................................................................................................................................................................................... 86 
 

  



Kroll V10 SP35 Feature Release Notes  6 

Kroll Version 10 Service Pack 35 Feature Release Notes  
This document is a compilation of new Features in Kroll Version 10 Service Pack 35. The purpose is to keep users 

informed of changes to the software and to help users implement and adapt to those changes. 

Important!  
Kroll Service Pack 35 will only operate on main stations and workstations running Windows 10 or Server 2016 and 
newer; Kroll will NOT open or function on unsupported versions of Windows. 
Please carefully read the details of KRL-18711 Warning Notification on page 33 and take special note of the 
subsequent hard stop in SP35. 

Adaptation 

[KRL-20341] Update existing Rx Adaptation screen to fully support Quebec regulations 

Feature 

The Rx Adaptation module now provides comprehensive support for Quebec-specific regulatory requirements. 

When the system province is configured to Quebec, pharmacists can document prescription adaptations using 

province-specific reason categories and supporting details that align with Quebec regulations. The adaptation screen 

presents four primary categories. Each category displays contextual subcategories that guide the pharmacist 

through the documentation process. 

Adjust the dose for supporting therapies 
 

The system prompts selection of the targeted therapy (such as 
anticoagulant therapy, asthma, chronic pain, diabetes mellitus, or other 
conditions) followed by the type of adjustment (Initial, Follow-Up, or 
Management Stopped). 
For dose adjustment therapies (excluding anticoagulant therapy), the 
system displays a warning when an initial interview for the same 
therapy has already been recorded on the same calendar day, though 
this does not prevent claim submission. 

Modify therapy to improve health 
 

Pharmacists select from specific justifications including correcting 
dosage errors, ensuring patient safety, factoring in organ function or 
weight, managing drug interactions, or reducing adverse effects.  

Therapeutic Substitution 
 

This requires documentation of the substitution reason, such as drug 
administration problems, patient safety risks, supply disruptions, or 
market withdrawals. 

Deprescribe or stop treatment 
 

Deprescribing actions capture the type of deprescribing as Initial, 
Follow-Up, or Management Stopped.  
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The system validates that all required reason fields contain valid entries before finalizing the adaptation, preventing 

submission with default "Not Answered" values.  

All interface elements and validation messages are available in both English and French to support Quebec's bilingual 

requirements. 

Adjudication 

[KRL-20431] Mapping of FFS Submission Codes for Rx Adaptations in Quebec (via RAMQ) 

Feature 

The system now correctly populates Fee For Service claims when submitting prescription adaptations to RAMQ in 

Quebec. The adjudication service automatically maps the appropriate Drug Identification Numbers (DINs), 

intervention codes, service codes, and program codes using the data in the Drug Service Card based on the type of 

adaptation selected by the user. The system supports four major categories of prescription adaptations:  

• Adjust Dose (including anticoagulation therapy and nine other therapeutic fields with initial, follow-up, and 

stop management service types) 

• Modification to Pharmacotherapy (supporting eleven different modification reasons) 

• Substitution (handling four different substitution scenarios with appropriate DIN selection from either the 

alternative or shorted medication) 

• Deprescribing (with initial, follow-up, and stop management service types) 

API  

[KRL-15741] eMAR API Consent Management  

Feature 

Kroll now supports eMAR API consent management for eMAR integrations. This feature enables compliant eMAR 

integrations with proper patient consent tracking and management for DOMedic and other eMAR systems. 

To enable this feature,  in File > Configuration > Kroll > Modules, select Kroll API (EMAR). Kroll Super Users have full 

access to this setting.  

To edit API User Consent Management options (eMAR consent types and schemas), a new screen has been added: 
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Access this screen from the main menu via Edit > Lists.  This screen is only visible when the eMAR module is enabled 

by a superuser. Here you can create and manage multiple consent schemas for different API integrators and support 

multiple API users with shared or separate consent configurations. If the Enhanced Consent checkbox is unchecked 

you will not see the EMar API Consent option in the Consents dropdown.  
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When entering patient consent, you will see the following screen:  

 

Select who provided consent: Patient, Agent, or blank (default: Patient). When an agent provides consent on behalf of 

a patient, only authorized agents with legal signing permissions appear in dropdown. Expired, revoked, deceased, or 

unauthorized agents are automatically excluded. 

When you specify the consent method, you have options of Written or Verbal (default: Written). 

• Written Consent: Save creates a pending consent record. The record remains pending until a signed form is 

scanned and attached.  

• Verbal Consent: Save immediately completes the consent record. The consent status is automatically set to 

Verbal Consent or Verbal Guardian Consent. 
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The consent description is automatically populated from the API User Consent configuration. 

 

[KRL-21002] Privacy Controls for eMAR Prescription Sharing 

Feature 

We've enhanced prescription management with new privacy controls that give you better control over which 

medications are shared with the configured eMAR systems. Changes include:  

• A new Do Not Send medication type option prevents prescriptions from being shared with eMAR when 

privacy is required. 

• Automatic prescription filtering – Prescriptions marked as Do Not Send are automatically excluded from 

eMAR integration 

• Dynamic privacy management – Change privacy settings at any time during prescription modifications or 

refills, and the system automatically updates what's shared with eMAR 

When you mark a prescription with a Do Not Send medication type, it will be kept private and not transmitted to your 

eMAR system. If you later change your mind, simply update the medication type and the prescription will be shared 

accordingly. 
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The system intelligently handles changes throughout the prescription lifecycle: 

• Switching a prescription to Do Not Send removes it from eMAR 

• Removing Do Not Send status makes the prescription available in eMAR 

[KRL-20021] Enhanced eMAR Barcode Integration for Packaging Reports 

Feature 

We've added comprehensive barcode printing capabilities across packaging reports to streamline integration with 

eMAR systems and improve medication tracking. The following features are now available:  

• Dispill and Distrimedic Reports now feature a Print eMAR Barcode option. This checkbox allows you to print 

reports with barcodes, patient ID, and ward information. You can choose between barcode-focused reports 

for eMAR scanning or standard detailed reports based on your needs. 

• Vial Labels have a new enhanced barcode format. This new barcode type combines your Kroll ID and 

transaction number for precise prescription identification.  

Auto-Refill Consent 

[KRL-18498] Add new Auto-Refill consent type 

Feature  

A new consent type was added to Kroll to provide enhanced consent capabilities for Auto-Refill functionality. This 

consent covers all methods of adding Auto-refill to a file, whether to a particular Rx via the auto-refill flag, through 

outbound communications, or through the new Enhanced RxSync feature (when enabled).  

[KRL-18496] Auto-Refill consent configuration 

Feature 

New consent configuration options for Auto-Refill enable pharmacy administrators to ensure regulatory compliance 

and maintain accurate patient consent records.  

Store-level consent configuration settings can be found at File > Configuration > Store > Rx > Auto-Refill.  
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When Require Consent for Auto-Refill is enabled, it becomes mandatory to collect patient consent before Auto-

Refill enrollment. The consent pop-up appears. When it is not enabled, consent is optional and the consent dialog 

does not appear unless you invoke the consent from the patient card. These settings apply immediately once 

configured, no restart is required.  

When  Enable Consent Expiration is enabled, the Consent Validity Duration field appears. You can set a consent 

validity period (12, 18, or 24 months). Otherwise, consent has no expiration date.  

For Quebec, the default settings are to require consent and enable consent expiration, with a default validity of 12 

months. For all other provinces, by default consent is not required and no consent expiration is configured.  

[KRL-18499] Auto-Refill Consent modal trigger (Enhanced RxSync workflow)  

Feature 

When a user selects Yes or No in the Auto-Refill consent section of the Synchronize + Auto-Refill screen,  the Auto-

Refill Consent modal launches so consent can be fully recorded.  
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Consent can be provided by a patient or their agent (guardian).  

[KRL-18500] Auto-Refill Consent modal trigger (Other Kroll triggered Auto-Refill workflows)  

Feature 

When Auto-Refill consent is required in the store configuration and the user triggers an Auto-Refill workflow, the 

system checks for an existing valid consent record. If a valid consent record exists:  

• If consent allows auto-refill (I consent status), the workflow proceeds as normal.  

• If a consent record exists with "I Do Not Consent", the save is blocked. An error message appears: 

"Patient has previously declined auto-refill consent. A new consent must be obtained before enabling auto-

refill functionality."  

If no consent record exists, the Auto-Refill Consent modal launches so consent can be recorded.  If the patient 

accepts Auto-Refill, the patient is enrolled or continues in the Auto-Refill program.  If the patient declines or cancels 

their Auto-Refill consent, save is blocked and the patient is not enrolled in Auto-Refill, or prescriptions in the program 

are removed.  
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 [KRL-18497] Auto-Refill consent questionnaire schema (Default TELUS version) 

Feature 

With this new consent schema, Kroll auto-links the Auto-Refill consent form to the correct patient and Auto-Refill 

Consent record and sets the consent status to completed.  

[KRL-18502]  Auto-Refill Consent Report support 

Feature 

The  Patient Consent Report (Reports > Patient > Patient Consent Report) now supports filtering for Auto-Refill 

Consent records.  

On the Patient Consent Report configuration screen’s Selection 2 tab, the Consent Type drop-down includes an 

Auto-Refill Consent option. You can choose consent statuses to include (Verbal, Written, None, etc.) and toggle to 

include revoked and/or expired consent records in the report.  

The report includes patient name, consent status, date, and comments and supports both patient-signed and agent-

signed (on behalf of dependent) consent scenarios.  
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Enhanced RxSync 

Enhanced RxSync is a chargeable module. Contact your TELUS sales representative for more information. 

[KRL-16776] Moving Store-Level Configurations for RxSync to its own Tab 

Feature 

 RxSync settings now appear on their own dedicated RxSync tab (under File > Configurations > Store > Rx tab) for 

better organization and easier access. (These settings previously appeared at   File > Configurations > Store > Rx tab 

> General tab.)  

 

 The following settings have moved to the new RxSync tab: 

•  Enable Retail Rx Refill Synchronization 

•  Minimum RxSync Proposed Days Supply 
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•  Maximum RxSync Proposed Days Supply 

•  Include Overdue Rxs due in past X days 

 All settings retain their current values and functionality; only their location has changed. 

[KRL-16775] Kroll-Level Configuration for RxSync 

Feature 

A new configuration option has been added to Kroll Config (File > Configuration > Kroll > Modules) to manage 

Enhanced RxSync functionality.  

 

•  Enabled: Users can access Enhanced RxSync config options in Rx > RxSync Store Config.  Legacy configuration 

options will be suppressed. 

•  Disabled: Users can access only legacy RxSync config options in Rx > RxSync Store Config. Enhanced 

configuration options will be suppressed. 
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[KRL-17238] Pre-qualification logic and Store-level configuration for Enhanced RxSync 

Feature 

When Enhanced RxSync is enabled in Configuration settings, the store-level RxSync tab (File > Configuration > Store 

> Rx > 11 – RxSync) has the following options:  

 

You can choose whether or not to include the following in the qualification evaluation and in the prescriptions 
automatically enrolled in the sync/program:  

• Controlled drugs 

• Narcotic drugs 

• Targeted substances 

• Unfilled prescriptions 

• Prescriptions renewed in the last [X] days 
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You can set the minimum number of qualifying prescriptions,  and a minimum days’ supply for new prescriptions to 

trigger re-sync.  

When Enhanced RxSync is enabled for a store, based on the qualification evaluation based on the settings above, the 
Enhanced RxSync button in the Profile menu has a status indicator.  

Icon Status Description 

 

Not qualified The patient is not pre-qualified and has not enrolled in the RxSync program. 

  

Qualified The patient is pre-qualified but not enrolled in RxSync. Requirements to be pre-
qualified are listed in Patient eligibility. 

  

Active The patient is enrolled in the RxSync program, with upcoming auto-refills.  

  

Declined The patient declined enrollment (consent opted out) in the RxSync program from 
the start and has never been enrolled.  

 

On pause The patient is enrolled in RxSync + Auto-Refill  but the program is currently on 
pause (a temporary stop to the program). See Pause RxSync + Auto-Refill program  
for more information.  

  

Stopped The patient was enrolled in the RxSync + Auto-Refill  program but later decided to 
opt out (putting a complete stop to the program). See Stop RxSync  + Auto-Refill 
program for more information. 

[KRL-16711] RxSync Options button and window 

Feature 

A new Enhanced RxSync button has been added to the Profile menu on the right side of the Patient Card to indicate 

a patient’s RxSync qualification status or status in the program.  

When you click the  Enhanced RxSync button, an options window opens: 
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 Options are: 

•   Synchronize Prescriptions - Perform a one-time prescription synchronization 

•  Synchronize + Auto-Refill - Sync prescriptions and enroll the patient in the Auto Refill program 

•  Cancel - Close the window without taking any action 

 Note: This feature is available when the Enhanced RxSync module is enabled for your location. 

[KRL-17710] RxSync-Only workflow 

Feature 

This workflow lets users select a sync date and treatment duration, review eligible prescriptions, and either fill 
them immediately or queue them. Future refill values will be pre-populated automatically. Note that each column 
has a hover hint explaining the data shown in the screen. To complete the workflow, follow these steps:  

1. Select Enhanced RxSync from the Profile menu.  

The RxSync Options window appears. 

2. Select Synchronize Prescriptions. 
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The Synchronization Only workflow opens.  

 
3. Note patient consent.  

If required in store configuration but not set on the patient card, the user will be prompted to enter it upon clicking 

on Synchronize.  

4. Select a Synchronization Date and Treatment Duration (in days). 

A prequalified list of prescriptions is shown in the Enrolled Prescriptions grid with system-calculated values. 

5. Review and optionally add prescriptions from the See all Rxs from profile section. 

Prescriptions can be removed from the Enrolled Prescriptions grid and moved to the bottom grid using the red X. 

6. Click Synchronize. 

The system prompts: Would you like to fill the prescriptions now or later? 

7. Choose one of the following.  

• Fill Now: Each prescription opens in the F12 screen with calculated quantity and days supply. User processes 
each Rx as usual 

• Queue for Later: Prescriptions are grouped and added to a Work Order in the To-Do Queue, retaining 

synchronization logic 

For all prescriptions, the system stores: 

• Next Fill Quantity 
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• Next Fill Days Supply 

These values will be used when the prescription is filled next time.  The workflow closes.  

[KRL-17712] RxSync + Autofill workflow  

Feature 

This workflow enrolls prescriptions into Auto-refill, in addition to synchronizing them to a common date. To 
complete the workflow, follow these steps:  

1. Select Enhanced RxSync from the Profile menu.  

The RxSync Options window appears. 

2. Select Synchronize + AutoRefill. 
The Synchronization + Auto-Refill workflow opens. 

 
3. Note patient consent.  

If required in store configuration but not set on the patient card, the user will be prompted to enter consent(s) upon 

clicking on Synchronize & Save. 
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4. Select a cycle duration and start date. 

A prequalified list of prescriptions is shown in the Enrolled Prescriptions grid with system-calculated values. 

5. Click on the magic wand icon to use a system suggested sync date.   

This suggestion will use the prescription for which the patient has the most on hand as the anchor med (the med to 

which all other prescriptions will be sync’d to). 

Alternatively, click on the anchor icon of any prescription in the top grid to sync all medications to that prescription's 

estimated next fill date. The anchor med will be highlighted.  

You can unlock individual Qty fields if you need to override the post-sync fill quantity (the next fill after the fill to sync 

the meds). 

For drugs flagged as “dispense as pack” the system highlights fractional quantities and issues a warning for any 

that are found.  

 
6. Review and optionally add prescriptions from the See all Rxs from profile section.  Prescriptions can be removed 

from the Enrolled Prescriptions grid and moved to the bottom grid using the red X. 

7. Click Synchronize & Save. 

A confirmation dialog appears if fractional quantities are detected.  Prescriptions can be  either filled now or 

queued for later. All qualifying prescriptions are automatically enrolled in Auto Refill, and the Auto-Refill program 

becomes visible on patient profile.  

The workflow closes.  

[KRL-18276] Post-Sync Program Management 

Feature 

When a patient’s program status is Active, clicking the Enhanced RxSync button will  launch directly into a 

comprehensive Program Management screen that displays consent information, program setup details, comments 

section, and program history. 
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When you click Enhanced RxSync in a patient profile, if the patient has an existing program status, the new Program 
Management screen opens.  

 

If the patient does not have an existing program status,  the RxSync Options screen opens instead.  

 

[KRL-20450] Existing prescription management 

Feature 

When filling enrolled prescriptions, a message will appear in the F12 screen warning area.  
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If you make a change to a synced prescription, this does not block the workflow. When the Program Management 
screen is re-opened, dates are recalculated using existing logic if any modifications and/or an early fill is 
processed on the prescription. 

[KRL-16713] RxSync: Post-Sync Logic for New prescriptions 

Feature 

After a patient has had an initial medication sync, when they have a new prescription, the system automatically initiates 
the appropriate flow (Synchronize or Synchronize + Auto-Refill). 

 

• Select No and the current prescription will not be synced. This does not disable future prompts or affect 

prior consent. 

• Select Yes  to trigger the appropriate sync workflow based on patient program status.  The system will 

present the user with a suggested synchronization quantity and days ‘supply for the new prescription 

according to the already synced meds, and will include newly added prescriptions in the sync or program 

moving forward. 

[KRL-18341] Program Lifecycle Management (Pause/Stop/Restart) 

Feature 

The Program Management screen can display Pause, Stop, and Restart buttons to manage the program lifecycle. 

You will always be asked to confirm if the action changes the functional state of the program.  

• Pause: To Do records are removed and Auto-refills are discontinued until you manually reactivate the program.  

Patient consent will remain opted in.  

• Stop: The program is terminated for the patient, and all data is lost. Patient consent is opted out.  

• Restart: The paused program is reactivated.  
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[KRL-17715] Program status reporting 

Feature 

You can now include RxSync participation information directly in your Patient Listing Reports. 

1. Navigate to Reports > Patient Listing Report. 

2. In the Selection 5 tab, choose a Program Status filter (All, Active, Declined, On Pause, Stopped). 

3. (Optional) Select Program Status as a column via the F2 column selector. 

4. Generate your report as usual. 

The report will generate contents based on the Program Status selection. If a Program Status column was selected, 

this column will provide status information for each row of the report.  

This feature is available in both English and French.  

 [KRL-16720] Reporting RxSync Status  

Feature 

You can now include RxSync status information directly in your Patient Profile Reports, making it easier to identify 

which medications are part of the synchronization program. 

5. Navigate to Reports > Patient Profile Report. 

6. In the Options tab, check the new  Include RxSync Status checkbox. 

7. Generate your report as usual. 

A new RxSync Status column will appear in your report.  Each prescription will show either: 

•  Synchronized: medication is part of the sync program 

•  Not Synchronized: medication is not synced 

This feature is available in both English and French.  

Kroll Care Plus powered by RxVigilance  

Kroll Care Plus powered by RxVigilance is a chargeable module. Contact your TELUS sales representative for more 

information.  
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[KRL-17497] RxvEngine | Support Vigilance's stand-alone Profile Analysis utility from the patient 

screen 

Feature 

Vigilance has an open-ended Web-based analysis page that allows users to manually enter in details to perform drug 

interaction checking. They also support the ability to receive details from the store to pre-populate their tool and then 

allow the user to change details to see how the analysis changes. These changes do not impact the patient record, 
they are just a tool for simulation. 

Stores that have purchased Kroll Care Plus do have the ability to access this tool through the Utilities menu. However, 

when the user selects this option, no patient details are included because there is no patient selected. Therefore, the 

tool always appears to the user in an empty state, forcing them to manually enter everything in. 

A new option has been added to the Patient screen to allow a user to perform the analysis with the stand-alone utility. 
This way, the web screen appears already pre-populated with patient details. 
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The existing Profile Editor option accessed from the Utilities > Vigilance Utilities menu has been re-labelled Profile 
Analysis. Selecting this option from the Utilities menu will continue to behave as in previous releases. No patient 

information will be included and must be inputted manually when the web utility appears. 

 

Lab results 

NOTE: This feature was originally implemented for QC in the DSQ Conformance branch, this case serves to make it 

available in all other provinces as well. 

[KRL-18794] Add 'Lab Results' as a new document type on the scan screen 

Feature 

A new functionality has been implemented to allow pharmacists to efficiently manage laboratory results by scanning 

them using the Utilities > Printed Document Scan/Import feature and saving them in the patient's record. This 

enhancement improves documentation, ensures better record-keeping, and provides easier access to historical lab 

results for patient care. 

A new Lab Results option has been added to the Document Type dropdown. When Lab Results is selected: 
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• The Patient selection field is displayed (similar to when Patient Document is selected). 

• The F3 button is available for patient selection. 

• A Title field is displayed. Data entered in the Title field is saved as the document's title in the Documents view 

in the F3-Patient Card. 

Processing a document with Lab Results selected saves it as a 'Lab Results' document in the patient's Documents. 

The event (document added to patient Documents) is logged in the patient’s history (F3 - Patient > History view). 

In F3 - Patient card > View > Patient Documents, lab results appear under their own document type. When viewing a 

lab result from Patient Documents, users have the option to print the document and edit its description. 

This new functionality allows pharmacists to properly manage lab results by scanning and processing these 

documents, which are then saved in the Patient Documents section of the patient profile. This improvement enhances 

record-keeping and provides easier access to historical lab results for patient care. 

Labels 

[KRL-18920] Update Drug Expiry Date details on the Vial label for Quebec 

Improvement 

The following changes have been made for all provinces: 

• Automatically update the Rx Drug Expiry Date field when entering Lot/Expiry dates using the Immunization 

Module 
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• Changed Expiry date to Discard by on the vial label for both laser and thermal labels 

Language Support 

When multi-language support is enabled, the following areas now allow users to enter and view content in both 

English and French:  

• [KRL-17087] Workflow queues 

• [KRL-21223] NH Groups 

• [KRL-20330] Workflow Action names 

• [KRL-20332] Master lists 

• [KRL-20334] Counselling points  

• [KRL-20400] Drug groups 

• [KRL-20402] Patient groups 

• [KRL-20404] Doctor groups 

• [KRL-20408] Drug department 

When multi-language support is enabled, screen elements will now appear in both languages so users can operate  

in their preferred language.  

When a store has  Multi-Language disabled, only a single language field appears (i.e. database default).  

When a store has Multi-Language enabled (English → French where Language 1=English and Language 2=French) if a 

user opens an element where multiple languages are supported, both English and French fields appear. The English 
field is marked as required and the French field is marked as optional.  

[KRL-17632] Search for and display allergies and conditions in the session’s language 

Feature 

Previously, When running a French database and you load a session in English the user that is running in that 
language sees the conditions and allergies in French. The same would happen if you are running an English DB 
and then run a session in French the allergies and conditions will only show in English. 

With this release, when using a Vigilance database, the following table applies:  
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Session language Task Descriptions/details language 
French inputting patient allergies and conditions French  
English  inputting patient allergies and conditions French  
English If a patient already has an allergy or condition on their 

file  
English 
 

French  If a patient already has an allergy or condition on their 
file  

French 
 

Screens affected include the following:  

• Allergies and Conditions lists on Patient card 

• Select an Allergy screen 

• Select a Condition screen 

• Patient Allergy Information screen 

• Patient Condition Information screen 

• Rx card 

• Clinical Verification workflow screen 

• Rx Counseling workflow screen (Counseling tab and Hardcopy tab) 

• Medication Review Selection screen (Allergies tab and Medical Conditions tab) 

• Immunization workflow screen 

• Embedded multiple Rx operation screen 

• ADT Message Overview screen 

• ADT patient allergies 

• ADT patient allergies deletion  

• ADT patient conditions  

• ADT patient conditions deletion 

• v2 PharmaNet adverse reaction list  

If the database does not have Vigilance, then previous behaviour with FDB will apply. 
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[KRL-17634] Provide the ability for users to easily launch a Kroll session in French or English 

Feature 

Kroll always opens in Session 1 in the language of the PC’s operating system (either French or English). Sessions 2-8, 

which allow you to connect to various databases, are also in the same language. To open a Kroll session in the non-

operating system language, follow these steps:  

1. With Kroll open, from the main menu, choose Session. 
2. Choose Open Session in French or Ouvrir la session en Anglais to open in the other language. 

  
A new Kroll session opens. The currently loaded session does not change language. 

3. Log into the new session.  

Both the new session and the old session are open. You can close either session as needed without affecting the 
other session.  

[KRL-17869] Allow Doctor Facing reports to print in doctor’s written language 

Feature 

The following reports can now be printed in the patient’s default language (English or French). The user can override 

the language selected.  

• KRL-17499: Doctor Rx filled Report  

• KRL-17500: Prescription Renewal Request 

• KRL-17501:  Patient / Primary Prescriber Ratio List  

• KRL-20762:  Pharmacist Adaptation Report   
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[KRL-16998] Allow reports to print in doctor’s or patient’s default language (English or French)  

Feature  

By default, the following reports now print in the doctor’s or patient’s default language (English or French). The user 

can override the language selected.  

• KRL-16999:  Patient Medical Expense report 

• KRL-17000: Patient Medical Expense Invoice report 

• KRL-17486:  Patient Medical History report 

• KRL-17488:  Patient Tax Receipt report 

• KRL-17489: Patient Compliance Label report 

• KRL-17490: Patient AR Taxes BreakDown Report 

• KRL-17491: Patient Profile Report 

• KRL-17492: Patient AR Invoice Report  

• KRL-17493: Patient AR Statement Report 

• KRL-17494: Patient AR Summary Report 

• KRL-17496: Patient Dispill Report 

For reports about an individual patient, the following table applies:  

  Patient Language set -
English 

Patient Language set -
French 

Patient Language other 
than EN/FR 
ex. Spanish 

Patient Language not set 

DB Language-
English 

Print Reports in 
English 

Print Reports in 
French 

Print reports in 
English 
(DB language) 

Print Reports in 
English 
(DB language) 

DB Language-
French 

Print Reports in 
English 

Print Reports in 
French 

Print Reports in 
French 
(DB language) 

Print Reports in 
French 
(DB language) 

For tables about multiple patients, the following table applies:  
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 Pat Lang=EN Pat Lang=FR Pat Lang=! EN/FR 
ex. Spanish 

Pat Lang not set User sets Lang=EN User sets lang=FR 

DB Lang=EN Reports in EN Reports in FR Reports in EN 
(DB lang) 

Reports in EN 
(DB lang) 

Reports in EN Reports in FR 

DB Lang=FR Reports in EN Reports in FR Reports in FR 
(DB lang) 

Reports in FR 
(DB lang) 

Reports in EN Reports in FR 

[KRL-20942] Standardize translation for “General Counseling” across all areas of Kroll application 

Improvement 

The French translation of “General Counseling” was standardized to “Consultation générale" in the following 

locations: 

• Patient Encounter tile view 

• Patient Encounter grid view 

• Patient Encounter View screen 

• Patient Dialog Report 

[KRL-21862] F7 - Doctor translation 

Improvement 

The French GUI for the  F7 – Doctor card has now been fully translated.  

Operating System 

[KRL-18711] Add an OS Check and Hard Stop for Unsupported Windows Version 

Feature 

Kroll Service Pack 35 will only operate on main stations and workstations running Windows 10 or Server 
2016 and newer; Kroll will NOT open or function on unsupported versions of Windows. 

Upgrading Kroll on a server or workstation running an unsupported operating system will not complete. 
After SP35 is installed on the server/main station, at the time Fill is started on any workstation in the 
pharmacy, an operating system check is run. If the OS is earlier than Windows 10 or Server 2016, Kroll will 
not open. An explanatory message will appear onscreen.  
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Patient Counselling 

[KRL-19383] Add Patient filter to Counselling Items workflow queue 

Feature 

Pharmacists are able to triage and counsel patients for their medications from a Counseling workflow queue 

(accessed via the F9 option). There was no ability for the user to filter out and search for a specific patient. The user 
would have to sort the Patient column and search for the patient in question. This was cumbersome. 

In this release, a new patient name filter has been added to this screen. Text typed in will return matches for both first 

and last name. The user can clear the filters by pressing Clear or Refresh. 

 

[KRL-18474] Allow multiple counselling items to be actioned at the same time  

Feature 

Pharmacists are able to triage and counsel patients for their medications from a Counseling workflow queue.  In 

previous releases, the user could tag multiple items in that queue to select records for counselling. However, the user 
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had to counsel each record individually. When tagging multiple prescriptions for the same patient, this could  become 

a bit tedious as the user had to repeat the counseling for each separately. Kroll has streamlined this process as 

follows: 

1. On the F9 Workflow screen, select Rx Counseling.  

2. Select and open two or more Rxs (flag them with the spacebar).  

When tagging rx’s from the Counseling workflow queue, the system will combine all rxs for that same patient into 

one Counseling session. 

The Save button becomes Save all Rxs for later.  

A new Rxs to Counsel menu in the top right shows every prescription selected for this patient. 

New Counsel this Rx later, Previous Rx and Next Rx buttons appear.  

 
As you go through the process to finalize counselling; you can navigate between all Rxs to review each one.  

• The Next button is only available if counselling has been accepted, and you are not currently reviewing the 
last Rx in the list.  

• The Previous button is only available if you are not reviewing the first Rx. 

• Click an item in the Rxs to Counsel menu to jump to that item.  
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When navigating between Rxs, the counseling information is saved. If you click Save all Rxs for later, you are 

returned to the grid, and whatever stage of data entry you were at is retained.  

3. If any Rx cannot be completed for whatever reason, click Counsel this Rx later.  

The prescription is removed from the list but stays in the main grid for future review. The menu option disappears, 

and if there were only two prescriptions selected for counseling, the screen reverts to single Rx mode.  

4. Once ALL Rxs have been reviewed, click Finalize Counseling.  

(The Finalize Counseling button is not enabled until counseling has been accepted for this patient AND each Rx has 

been reviewed.)  

The screen closes, and those  Rxs are updated individually and removed from the grid. 

If you selected multiple Rxs for 2 or more patients,  all Rxs for one patient can be reviewed in a list first, and then the 

next patient will be loaded with a list of Rxs to review. Each patient is handled separately, but each patient can have 

multiple Rxs reviewed in the same session. 

Quebec RAMQ Pricing 

[KRL-17011] Code Updates - RAMQ Special Plan codes 

Improvement 

The RAMQ Special Plan Code selection has been updated to reflect current program requirements and improve 

interface usability.  

Special plan code 04 for emergency contraception has been removed from the system as it is no longer in use.  

Three missing special plan codes have been added: 

• Code 09 for medical abortion (abortion pill).  

• Code 2R for patients with ultra or multiresistant tuberculosis. 

• Code 2S for contacts with persons with ultra or multiresistant tuberculosis.  

Descriptions for all special plan codes have been reviewed and updated in both English and French to align with Kroll 

functionality and current RAMQ terminology.  
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All special plan codes populate the outbound RAMQ message CodPgmMed field with the appropriate code value 

when selected. 

[KRL-17012 & KRL-20223] RAMQ Fees Screen Enhancements and Service Code Description Updates 

Improvement 

The RAMQ Fees screen now provides enhanced fee code configuration capabilities and updated service code 

terminology for Quebec pharmacy billing.  

• Users can configure fee codes M2 and M3 through dedicated popup windows that present three separate fee 

entry options for mixture preparations, including capsule-specific pricing for preparations made with or without 

capsule filling devices.  

• The W fee code section has been restructured into three distinct frames for W, W1, and W2, each supporting 

initial and follow-up service entries for therapeutic target adjustments and deprescription services.  
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Service code descriptions and labels throughout the RAMQ billing interface have been updated to reflect current 

terminology standards: 

Service Code New label/description Old label/description 
Service code 5 Retroactive claim of service(s) 

delivered 
Retroactive 

Service code E Nutritional Formula Dietetic 
Service code Q NaCl Syringing NaCl Inj. 
Service code 6 Chronic less than 7 days Half-Fee 

Mixture service codes M1, M2, and M3 now include category identifiers in their descriptions.  

These description updates apply consistently across the RAMQ Fees screen and Drug Plan and Plan Information 
screen service code selection.  

French translations have been integrated throughout all modified screens to support bilingual operation. 

[KRL-17154] Adjustment to the Patient Plan Information Screen to make checkboxes more visible 

Improvement 

The Patient Plan Information screen interface has been enhanced to improve checkbox visibility and user 

interaction. The Always Use in Rx checkbox now includes five pixels of padding above and below the control area, 

providing spacing equivalent to text box label formatting standards.  
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This adjustment increases visual clarity and reduces interface crowding in the plan configuration section, making the 

checkbox control more readily identifiable during plan setup and modification workflows. 

[KRL-17226, KRL-17227, KRL-17228, KRL-17229] Addition of support for encapsulated mixture pricing 

calculations  

Feature 

The RAMQ mixture billing system now supports encapsulated mixture fee calculations with category-specific pricing 

for manually prepared and filler-prepared capsules. Eight new provincial PIN options have been added to the drug 

mixture card screen for Category 2 and Category 3 preparations, including the following options for each category:  

• Prepared placebo capsules manual 

• Prepared capsules manual 

• Prepared placebo capsules using a filler 

• Prepared capsules using a filler  
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The mixture plan screen for RAMQ has been restructured into three functional frames organizing plan details, pricing 

configuration, and drug details, with the pricing frame displaying first when the subplan is RAMQ. The service code 

combination field now separates into distinct SSC Code and SSC Type fields when mixture-specific codes are 

selected, with the SSC Type field appearing for codes M1, M2, M3, *2, *3, *4, and *5 (* is a wild card placement for O, 

N, 6, P, G) while the PDIN/DIN fields become hidden. This was also expanded to non-mixture-specific codes J, Q, R, T, 

VA, V, W2, W1, and W as they too require SSC Types to be associated. In a mixture, when Provincial PIN selections are 

made, the selections are automatically populated in the SSC Code and SSC Type fields in the format code-type and 
the combined values are stored in the SSC backend field. 

 

Fee calculation logic has been implemented for twenty new encapsulated mixture service codes across five base 

service codes.  

Base service code Calculation logic 
Base code O The system calculates fees O2 through O5 by adding the base code fee to the category-

specific per-capsule fee multiplied by dispensed quantity, accounting for new versus 
refill status and threshold conditions. 

Base code N Calculations N2 through N5 apply the base code fee plus category-specific per-capsule 
fees multiplied by dispensed quantity with threshold and maximum value considerations. 
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Base code 6 Calculations 62 through 65 add the base code fee determined by new or refill status and 
threshold to the category-specific per-capsule fee multiplied by dispensed quantity. 

Base code P Calculations P2 through P5 apply the base code fee scaled by days supply intervals to 
the category-specific per-capsule fee multiplied by dispensed quantity. 

Base code G Calculations G2 through G5 add the base code fee scaled by days supply intervals and 
threshold conditions to the category-specific per-capsule fee multiplied by dispensed 
quantity. 

The Rx Plan Information screen Service Code 1 dropdown now includes all twenty encapsulated mixture codes with 

proper SSC mapping. Encapsulated mixture codes are restricted to mixture drug types and cannot be applied to 

standard drug products.  

French translations have been implemented for all new provincial PINs, service codes, and interface elements. 

[KRL-17230, KRL-20366, KRL-20484, KRL-20485] Quebec therapeutic adjustment billing support 

with enhanced Service code functionality for RAMQ 

Feature 

The system now supports comprehensive Quebec-specific therapeutic adjustment billing through enhanced Service 

Code functionality for RAMQ claims. Users can configure and bill therapeutic adjustment services using three distinct 

service codes:  

• W for anti-coagulation therapy adjustments 

• W1 for deprescription services 

• W2 for dose adjustments across multiple therapeutic fields 

The system calculates fees dynamically for initial and follow-ups as per the current RAMQ Fee Schedule. 

The Drug Plan Information screen has been reorganized for Fee for Service drug cards when RAMQ is selected. A 

new SSC Type field appears when applicable service codes are selected. 
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Service code descriptions for the Therapeutic Adjustment codes have been updated across all RAMQ fee screens for 

accuracy in both English and French. The RAMQ Fees screen has been optimized for fee code controls within the 

Therapeutic Adjustment group box to accommodate extended description text. The VA - Vaccination group box 

was repositioned to reduce vertical scrolling. 

The system now includes the DIN from adapted prescriptions in the outbound RAMQ message within the ListProduits 

segment when the Adaptation Module is used to create Fee for Service claims for W1 deprescription services. For all 

three service codes, the system will:  

• Validate that intervention codes are present  and display warnings when missing 

Code Intervention code 
W  KG 
W2 KA, KB, KC, KD, KE, KF, KH, KI, KJ, or QI 

• Automatically apply Special Plan Code 07 when W, W1, or W2 code is selected 

• Enforce that prescriptions must be marked as Written, Faxed, or e-Rx 
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[KRL-17231] RAMQ service code and service type override capability in plan information screen 

Feature 

The RAMQ Plan Information screen now provides pharmacy users with the ability to override both Service Code 
and Service Type values for prescriptions requiring non-standard RAMQ billing configurations. A Service Type text 

field displays for specific service codes that require type designation, while maintaining the Provincial DIN (PDIN) and 
DIN combination fields for service codes that do not utilize service type classification.  

• When users enable the Service Override checkbox, both the Service Code and Service Type fields become 
editable, allowing manual specification of billing parameters.  

• The Service Type field appears exclusively when the selected Service Code is one of the following: Q, R, M1, 

M2, M3, T, J, VA, V, W2, W1, W, CV, or encapsulated mixture variant codes (O2, O3, O4, O5, N2, N3, N4, N5, 62, 
63, 64, 65, P2, P3, P4, P5, G2, G3, G4, G5).  

Override functionality applies to both fields simultaneously, with changes reverting to drug card defaults or 

prescription logic when the override checkbox is unchecked. 
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[KRL-17678 & KRL-20763] RAMQ fee threshold configuration relocated to store-level settings 

Feature 

RAMQ fee threshold controls have been relocated from Edit > RAMQ Fees to File > Configuration > Store > Rx > 

Pricing. The Threshold Met checkbox and associated threshold configuration now appear within a new RAMQ Fee 
Thresholds frame on the Pricing screen, visible only for Quebec-configured Kroll instances.  

 

This relocation ensures threshold settings remain store-specific and are not managed by Kroll Central Maintenance 

(KCM), as threshold status varies independently from store to store. When the Threshold Met checkbox is enabled, 

post-threshold pricing values are applied for applicable RAMQ service codes during claims adjudication.  

The checkbox automatically resets to unchecked status at the beginning of each calendar year, requiring manual re-

enablement when threshold conditions are met. Session restart is required after modifying threshold settings for 

changes to take effect during adjudication processing. 
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[KRL-17679 & KRL-17969] Enhanced chronic medication service code selection for RAMQ billing with 

days supply evaluation 

Feature 

The Chronic button functionality for RAMQ billing now provides pharmacy users with improved service code 

selection capabilities when processing chronic medication prescriptions. The Chronic button now only  displays for 

applicable service codes (O, N, 6, and encapsulated mixture variants) while remaining hidden for services, non-
encapsulated mixtures, and pill pack prescriptions.  

 

When users activate the Chronic button for prescriptions with a days supply of less than seven days, the system now 

presents a Chronic Code Selection prompt requiring explicit user selection between Service Code N and Service 
Code 6, rather than automatically defaulting to Code 6.  

• Service Code N applies to prescriptions for health problems or medical conditions requiring treatment for 
ninety days or more in solid oral dosage forms.  

• Service Code 6 applies to subsequent prescriptions for chronic medical conditions with days supply of less 

than seven days in cases provided for in RAMQ rules 25 and 19 (first fills require code O).  
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For encapsulated mixtures, the system will automatically apply the appropriate variant codes (N2, N3, N4, N5, 62, 63, 

64, 65) based on the selected base code and mixture category. 

The Go Back button (or closing the prompt via the ESC key) returns users to the prescription screen without applying 

changes, deactivating the Chronic button and reverting to the previously assigned service code. Users can invoke 

selections via button click or keyboard shortcuts (N key for Service Code N, 6 key for Service Code 6).  

For prescriptions with seven or more days supply, the system continues to apply Service Code N automatically as 

previously implemented. The Chronic button now remains visible and accessible when Service Code 6 or Service 
Code N is applied, so users can deactivate chronic status, remove the service code override, and apply the default 
code from the drug card or the standard code for the drug type. 

[KRL-18054] View patient's current RAMQ monthly contribution and maximum amount via a hover hint 

on the patient card 

Feature 

A hover hint was added to the patient card for Quebec pharmacy users to display the patient's current RAMQ monthly 

contribution and maximum amount, enabling faster assessment of prescription requests and more accurate patient 
payment information. 
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[KRL-18441] RAMQ mixture proportion validation expanded to support Units measurement for 

specific service codes 

Improvement 

RAMQ mixture billing validation now accepts Units as a valid proportion measurement type for prescriptions utilizing 

the following service codes: 

•  I (Insulin Syringing)  

• Q (NaCl Syringing) 

• R (Ophthalmic) 

• T (Parenteral) 

These service codes were previously exclusively restricted to mixtures configured with Bags/Capsules proportion 

type. The validation logic now permits both Bags/Capsules and Units as acceptable proportion measurement types.  
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When users attempt to bill mixtures using service codes I, Q, R, or T with proportion types other than Bags/Capsules 

or Units, a validation message prevents submission until the mixture proportion configuration is corrected.  

English validation message French validation message 
Mixture proportions must be set to Units or 
Bags/Capsules 

Les proportions de la magistrale doivent être saisies en 
Unités ou Sacs/Capsules 

This adjustment accommodates RAMQ billing requirements for mixtures that require unit-based measurement while 

maintaining validation controls to ensure appropriate proportion type selection for specialized pharmaceutical 

preparations including insulin syringes, sodium chloride preparations, ophthalmic formulations, and parenteral 

nutrition solutions. 
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[KRL-18442] Automatic service type L assignment for encapsulated mixtures billed under RAMQ 

special program code 40 

Feature 

The system now automatically applies Service Type L (compound medication under special program 40) when 

pharmacy users select RAMQ special program code 40 for encapsulated mixture prescriptions.  

When users access the Plan Information screen and apply program code 40 - Patient with exception  to 

prescriptions containing mixture service codes M1, M2, M3, or encapsulated mixture variant codes (O2, O3, O4, O5, 

N2, N3, N4, N5, 62, 63, 64, 65, P2, P3, P4, P5, G2, G3, G4, G5), the system automatically enables the service override 

checkbox and populates the Service Type field with code L. This automatic assignment ensures compliance with 

RAMQ billing requirements that restrict special program code 40 claims for compound medications to Service Type 
L exclusively.  

 

When users remove or modify the special program code 40 designation, the system automatically unchecks the 

service override and reverts the Service Type to the value stored in the mixture drug card plan, or to M1 if no plan 
information exists.  
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If users manually change the Service Code selection to a value outside the mixture code categories while special 

program code 40 remains active, the system removes Service Type L while maintaining the override checkbox in 

checked status. Manual Service Type modifications override the automatic L assignment regardless of special 
program code status.  

The prescription validation engine enforces the Service Type L requirement at the prescription screen level, 

preventing submission of encapsulated mixture prescriptions with special program code 40 when the Service Code 
and Service Type combination does not match the required pattern of mixture code with Service Type L, displaying 

the error message Invalid Service Code [code] for plan RAMQ when validation fails. Canceling or closing the Plan 
Information screen without confirmation discards all service code and service type changes, preserving the original 
plan information settings. 

[KRL-18650] Decouple the usage of PDIN for the storage of Service Codes and Types 

Improvement 

The storage and management of Service Codes and Service Types has been separated from the Pseudo DIN 
(PDIN) field. This provides more flexibility and efficiency in handling Service Codes and Service Types 
independently of the PDIN field. 
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The decoupling of PDIN from Service Codes and Service Types offers the following benefits: 

• Improved data management: By separating these elements, it becomes easier to maintain and update Service 
Codes and Service Types without affecting the PDIN field. 

• Reduced dependencies: Decoupling these elements reduce potential conflicts or limitations that arise from 
tying Service Codes and Service Types directly to the PDIN field. 

[KRL-18869] Migration of PDIN Data to SSC Code and Type Fields for RAMQ 

Feature 

Service codes stored in the PDIN field have been transferred to the SSC Code and SSC Type fields for RAMQ pricing 

changes. The migration process evaluates drug, mixture, and service cards according to specific rules.  

 

When the PDIN field contains a valid service code in the format 'X-X' (e.g., W-A, M1-B), the system automatically: 

• Populates the SSC Code and SSC Type fields with the corresponding service code information 

• Clears the original PDIN field contents 

• Maintains the connection between SSC codes and Provincial PINs (mixtures) 

• Applies the migrated SSC codes to active prescriptions, refills, and drugs in progress of being filled 
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The migration ensures proper evaluation of pricing rules, service code types, and fee calculations for RAMQ claims 

processing while preserving existing functionality for other plans. 

[KRL-18870] RAMQ Vaccination Service Code VA Workflow Simplification and Special Program Code 

07 Automation 

Improvement 

Vaccination billing workflows for RAMQ service code VA have been simplified by: 

• Removing deprecated pandemic-related validation logic  

• Automating special program code assignment  

Pandemic-specific fee types (VA-C, VA-D, VA-E, VA-F) and associated validation checkboxes (Under pandemic 
conditions only and For Influenza) have been removed from the RAMQ Fees screen, streamlining the interface to 

support only current vaccination billing scenarios.  

The service type VA-B label has been updated to reflect current RAMQ terminology for vaccination administration by 

authorized healthcare professionals other than pharmacists.  

Old label  New label – English New label - French 
B – Nurse B – Other Authorized Person B – Autre personne habilitée 

 

 

The following were removed:  

• Hardcoded DIN-based validation logic that previously evaluated specific influenza vaccine products  

• Prescriber designation checks that determined service type based on whether the prescriber on the Rx was 

designated as a pharmacist or nurse 

Fee calculation now relies solely on service type designation (A or B) being added, with the CodTypServMed value in 

RAMQ claim requests set to the user-specified service type rather than being derived from the prescriber 
designation. 
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A new Special Program Code Override checkbox has been added to the Plan Information screen, so users can 

control automatic special program code 07 assignment.  

• When the override checkbox is unchecked and service code VA (or V, SP, DC, Y, W, W1, W2, IU, 4) is applied, the 

system automatically assigns special program code 07.  

• When the override checkbox is checked, users can manually specify alternative special program codes without 

automatic assignment. 

 A warning  appears when service code VA (or V, SP, DC, Y, W, W1, W2, IU, 4) is used without special program code 07, 
allowing users to proceed with submission while maintaining awareness of standard requirements.  

English warning French warning  
Service Code [Code] usually requires special plan 
code 07 for plan RAMQ 

Le code de service [Code] requiert généralement le code 
de programme 07 pour RAMQ 

Service type validation enforces the requirement for type specification, presenting an error  when service code VA is 
applied without a type designation. 

English error French error  
Service Code VA requires service type for Plan 
RAMQ 

La RAMQ exige un type de service pour le code de service 
VA 

 

[KRL-18901] RAMQ Product Selection Handling for "Prescriber's Choice" | INFOLETTRES-067 

Feature 

The system now supports streamlined product selection handling for RAMQ claims when 1 - Prescriber's choice is 

selected. When users select this option during prescription entry for RAMQ patients, the CodSelecMed value is 

automatically set to "1" in the outbound claim request without prompting for additional NPS (Do not substitute) reason 

input. The NPS Reason popup has been suppressed for this selection, and the NPS Reason field has been removed 
from the RAMQ Plan Information screen.  
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This change aligns with RAMQ's updated reimbursement rules that no longer accept alternative NPS reason codes 

(A, B, C, or D) and require only numeric product selection codes. The system continues to handle other product 

selection options (2 - Patient's choice, 3 - Pharmacist's choice, 4 - Existing Therapy, and None) with their 

respective CodSelecMed values transmitted to RAMQ as specified. 

[KRL-18902] RAMQ Naloxone Program DIN Expansion and Service Code Label Update 

Improvement 

Additional Drug Identification Numbers (DINs) for RAMQ special programs 8K and 8L related to naloxone products 

are now supported.  

Validation list New DINs 
Program 8K 02511568  

02548194 
Program 8L  99114400  

99114401 
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The system continues to enforce program code requirements, presenting validation errors when prescriptions for 

these DINs are processed without the appropriate 8K or 8L program code designation, or when these program codes 

are applied to non-qualifying DINs.  

 

Additionally, the service code EN label has been updated across multiple interface locations to reflect current 

program terminology.  

Old label New English label New French label  
EN - Naloxone Consultation EN - Naloxone Education EN – Enseignement sur la naloxone 

This label change appears on the Edit > RAMQ Fees screen and in the SSC combo box on both the Drug/Mixture 
Card and Plan Information screens. 

[KRL-18903] RAMQ Opioid Treatment Service Code J Handling Enhancement 

Improvement 

The system now provides enhanced flexibility for RAMQ service code J (Treatment of opioid use disorder) by 
removing hardcoded Suboxone-specific logic and enabling user-controlled service type designation.  
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Previously,  service type B was automatically applied when using service code J with Suboxone drugs and service 

type A was applied for other opioid medications. Users can now explicitly  specify the appropriate service type (A, B, 

or C) through:  

• The Provincial PIN selection for mixtures 

• The SSC Code and SSC Type fields on the Drug card for RAMQ plans   

• By override in the Plan Information screen 
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The CodTypServMed value transmitted in claim requests now reflects the user-selected type rather than drug-

based automatic assignment. Service code J validation has been refined to require service type specification, 

presenting an  error when the type is missing.  

English Error French Error 
Service Code [Code] requires service type for Plan 
RAMQ 

La RAMQ exige un type de service pour le code de 
service [Code] 

Interface labels have been updated across the RAMQ Fee screen and Provincial PIN list to reflect current 

terminology:  

Old display term New English display term New French display term 
J-A J - Opioid Supervised (A) J – TUO – Supervision (A) 
J-B J - Opioid Different Strengths (B) J – TUO – Teneurs différentes (B) 
J-B Provincial PIN description Opioid use disorder treatment 

(different strengths) 
Traitement du trouble lié à l'utilisation 
d'opioïdes (teneurs différentes) 
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[KRL-19047] RAMQ Service Code Y Label Update and Special Program Code 07 Requirement 

Removal 

Improvement 

The system previously required special program code 07 to be applied in conjunction with service code Y before 

RAMQ claim submission, presenting the error Invalid Service Code Y for Plan RAMQ when code 07 was absent. 

This validation requirement has been removed, as special program code 07 is now only applicable during specific 
scenarios such as vaccination services and emergency situations.  

Updated terminology for RAMQ service code Y now displays across all interface locations. A mandatory requirement 
for special program code 07 when service code Y is applied has been removed.  

Old display terminology New English  New French 
Y - Spacing Chamber Mask Y - Supply without Fees Y – Fourniture sans honoraires 

The updated service code Y label appears on the RAMQ Fees screen, the Drug/Mix Card plan screen, and the 

RAMQ Plan Information screen. This label change reflects current RAMQ program terminology for supply 
transactions that do not include professional fees.  
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Users can now submit RAMQ claims with service code Y independently, with or without special program code 07 

designation, based on the specific clinical context of the transaction. 

[KRL-19048] RAMQ Service Code DC Validation and Special Program Code 07 Automation 

Improvement 

The system now enforces enhanced validation requirements and automates special program code assignment for 

RAMQ service code DC (Billing for a Request for Consultation Addressed to a Pharmacist). When service code DC is 

applied to a prescription, either through the drug card or manual override in the Plan Information screen, special 
program code 07 is automatically applied if the special plan code field is not in override mode.  

A warning appears when service code DC is used without special program code 07, allowing users to proceed with 

submission while maintaining awareness of standard requirements. 

English Warning French Warning 
Service Code [Code] usually requires special plan code 
07 for plan RAMQ 

Le code de service [Code] requiert généralement le 
code de programme 07 pour RAMQ 

Intervention code validation has been implemented to display a warning when no intervention code is specified, 

though users may still submit claims as RAMQ performs final intervention code validation. 

English Warning French Warning 
Service Code DC requires an intervention code for Plan 
RAMQ 

Le code de service DC requiert un code d'intervention 
pour RAMQ 

The system now requires Written, Faxed, or e-Rx designation in the Oral/Written field when service code DC is 

applied, presenting the error You must specify Written, Faxed or e-Rx for this drug when other selections are 

made. This validation is suppressed for drug cards configured with Oral or Written or Written Only settings when 

service code DC is active.  

The RAMQ fee cost for service code DC is now applied and included in outbound claim transmissions, with the 

prescriber requesting the consultation placed in the NoDispPresc tag (based on the doctor card used in the F12 

screen) and the pharmacist conducting the consultation placed in the NoPharmDispServ tag (based on the initials of 

the pharmacist on the F12 screen) within the claim message structure. 

[KRL-19049] RAMQ Service Code V Type Assignment and Validation Enhancement 

Improvement 

Previously, the system automatically determined and applied service type values (A, B, or C) when service code V was 

used, deriving the type from intervention code selections. The system now transmits the user-specified SSC type 

value directly in the CodTypServMed field of RAMQ claim requests without automatic type derivation.  
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The system now requires explicit service type specification for RAMQ service code V (Prescribing a drug or initiating 

drug therapy) and has removed automatic type assignment logic based on intervention codes and service fee types.  

 

When service code V is applied without an associated service type, an error message prevents claim submission until 

the type is specified.  

English error message French error message 
Service Code V requires service type for Plan RAMQ La RAMQ exige un type de service pour le code de 

service V 

Intervention code validation has been implemented to display a warning when no intervention code is provided, 

though users may proceed with submission as RAMQ performs final intervention code validation.  

English Warning French Warning 
Service Code V requires service type for Plan RAMQ Le code de service V requiert un code d'intervention 

pour RAMQ 

The system continues to automatically apply special program code 07 when service code V is used (allowing a user 

override if necessary), maintaining consistency with RAMQ requirements for vaccination and emergency service 

scenarios. Users must now explicitly configure service type (A, B, or C) on drug cards or through manual override in 

the Plan Information screen to satisfy claim submission requirements for service code V transactions. 
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[KRL-19051] RAMQ Service Code F Label Update and Intervention Code Validation Enhancement 

Improvement 

The system now displays updated terminology for RAMQ service code F and implements generic intervention code 

validation.  

The service code F label has been changed across all interface locations including the RAMQ Fees screen, the 

Service Code 1 combo box on the Plan Information screen, and the SSC Code combo box on the Drug Card plan 

screen. 

Old label New English label New French label 
F - Needle F - Syringe/Needle F – Seringues et aiguilles 

This label change reflects current RAMQ program terminology for syringe and needle supply services.  

 

Intervention code validation now presents a generic warning when service code F is applied without any intervention 

code, replacing the previous hardcoded intervention code list validation.  
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English Warning French Warning 
Service Code F requires an intervention code for Plan 
RAMQ 

Le code de service F requiert un code d'intervention 
pour RAMQ 

This warning allows users to proceed with claim submission, as RAMQ performs final validation of intervention code 

accuracy. When an intervention code is provided, regardless of whether it matches current RAMQ-accepted codes 

(LA, LB, LC, LD, LE, LF), the system clears the warning and permits claim submission.  

This approach accommodates any changes to intervention code requirements without necessitating code 

modifications, as the system validates presence rather than specific code values. 

[KRL-19052] RAMQ Service Code SP Special Program Code 07 and Prescription Type Validation 

Improvement 

The system now enforces automatic special program code 07 assignment and prescription type validation 

requirements for RAMQ service code SP (Management of palliative care patients).  

 



Kroll V10 SP35 Feature Release Notes  63 

When service code SP is applied to a prescription, either through the drug card configuration or manual override in 

the Plan Information screen,  special program code 07 is automatically applied if the special plan code field is not in 

override mode. A warning  appears when service code SP is used without special program code 07, allowing users to 
proceed with submission while maintaining awareness of standard requirements.  

English Warning French Warning 
Service Code SP usually requires special plan code 07 
for plan RAMQ 

Le code de service SP requiert généralement le code 
de programme 07 pour RAMQ 

Prescription type validation requires Written, Faxed, or e-Rx designation in the Oral/Written field when service code 

SP is applied, presenting the error You must specify Written, Faxed or e-Rx for this drug when other selections are 

made. This validation is suppressed for drug cards configured with Oral or Written or Written Only settings when 

service code SP is active, while maintaining the validation for all other service codes.  

These enhancements align service code SP handling with existing special program code 07 automation logic 

implemented for other RAMQ service codes. 

[KRL-20085] RAMQ Service Code T Fee Calculation Base Rate Correction and Elastomeric Infuser 

Label Updates 

Improvement 

The system now calculates RAMQ service code T (Parenteral Therapy billing) fees using the correct base rate for new 
prescriptions rather than refill prescriptions. 

Previously,  the base rate for prescription refills was applied when calculating fees for service code T, which resulted 

in incorrect fee amounts. The system now uses the base rate for new prescriptions, aligning with RAMQ pricing 

agreement specifications that establish service code T fees at the same base rate as service code O for new 

prescriptions. This correction affects all service code T type variations (A through L).  

Additionally, Provincial PIN and RAMQ Fee Screen labels for elastomeric infuser services have been updated from 

"Elastometric Prefusor" terminology to current RAMQ standards:  

Elastometric Prefusor 
Service type 

New English display New French display 

T-I Elastomeric infusers with preparation Perfuseurs élastomériques avec 
préparation 

T-J Elastomeric infusers without preparation Perfuseurs élastomériques sans 
préparation 

The system continues to enforce service type validation, presenting an error when service code T is applied without a 

type designation. 
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English Error French Errror 
Service Code T requires service type for Plan RAMQ La RAMQ exige un type de service pour le code de 

service T 

[KRL-20173] RAMQ Intervention Code Validation Standardization for Multiple Service Codes 

Improvement 

Previously, the system displayed service-code-specific errors that listed accepted intervention codes for service 

codes. These hardcoded intervention code lists required software releases whenever RAMQ added intervention 

codes, potentially blocking users from submitting valid claims with newly approved codes.  

Standardized intervention code validation has been implemented across multiple RAMQ service codes, replacing 

code-specific validation messages with a unified generic warning that accommodates frequently changing RAMQ 
intervention code requirements.  

A generic warning appears for all service codes requiring intervention code designation: V, F, DC, 7, W, W1, W2, RA, 

AD, and PH.  

English Warning French Warning 
Service Code [Code] requires an intervention code 
for Plan RAMQ 

Le code de service [Code] requiert un code 
d'intervention pour RAMQ 
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This warning validates intervention code presence rather than specific code values, allowing users to proceed with 

claim submission when any intervention code is provided, regardless of whether it matches previously hardcoded 

lists. RAMQ performs final validation of intervention code accuracy during claim adjudication.  

When an intervention code is applied through drug card configuration or manual entry in the Plan Information screen, 

the system clears the warning and permits claim submission. This approach eliminates the need for software releases 

to accommodate RAMQ's evolving intervention code requirements while maintaining user awareness of intervention 

code necessity for applicable service codes. 

[KRL-20175] RAMQ Service Code I Label Update for Insulin Syringe Preparation 

Improvement 

The system now displays updated terminology for RAMQ service code I to accurately reflect insulin syringe 

preparation services.  

The service code I label has been changed across all interface locations including the RAMQ Fees screen, the 

Service Code 1 combo box on the Plan Information screen, and the SSC Code combo box on the Drug Card plan 
screen.  
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Old label  New English label  New French label  
I - Insulin I - Insulin Syringing I – Mise en seringue d'insuline 

 

On the RAMQ Fees screen, the quantity-based fee labels have been updated to provide clearer service identification.  

Old label  New English label  New French label  
1-16 I - Insulin Syringing (1-16) I – Mise en seringue d'insuline (1-16) 
17 or more I - Insulin Syringing (16 or more) I – Mise en seringue d'insuline (17 ou plus) 
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These label changes reflect current RAMQ program terminology for insulin syringe preparation services. The system 

continues to calculate fees based on the number of syringes dispensed, applying the appropriate fee tier for 1-16 

syringes or 17 or more syringes for both standard insulin dispensing and insulin mixture preparations. For 

prescriptions involving multiple insulin types or multiple syringe types, each combination is billed on a separate claim 
line as required by RAMQ billing protocols. 

[KRL-20224] RAMQ Service Code CV Pandemic Services Removal 

Improvement 

RAMQ service code CV (Pandemic Services) and all associated functionality have been removed from the 

application, reflecting the discontinuation of pandemic-related billing requirements.  

Service code CV and its type variations (A, B, C, D) have been removed from all interface locations including the 

RAMQ Fees screen, the SSC Code combo box on the Drug Card plan screen, and the Service Code 1 combo box 

on the Plan Information screen. The RAMQ Fees configuration screen no longer displays the CV - Pandemic 
Services fee entry or the associated fee detail screen for type-specific fee configuration. For drug cards configured 
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with service code CV prior to this update, validation has been implemented to prevent the use of invalid service 

codes.  

When a drug card containing service code CV is opened, a warning dialog appears:   

 English French  
Warning title Invalid Code Code non valide 
Warning message [code] is not a valid SSC Code [code] n'est pas un code CSS valide 

Upon acknowledgment of this warning, the Drug Card plan screen displays with the SSC Code combo box reset to 

(None) and the service type field cleared. When the drug card is saved, the invalid service code CV value is removed 

and stored as blank, preventing the deprecated code from being applied to prescriptions. The system treats drug 

cards with invalid service codes as if no service code is present, ensuring that prescription processing continues 

without attempting to apply the removed pandemic service code functionality. 

[KRL-20299] RAMQ Service Code Prescription Type Validation for Written Prescription Requirement 

Improvement 

The system now enforces prescription type validation for RAMQ service codes that require written prescription 

designation according to RAMQ's "Nature and expression of N" requirements. The system validates that the 

Oral/Written field contains a selection of Written, Faxed, or e-Rx when any of the following service codes are applied 

to a prescription: 

• J (Treatment of opioid use disorder) 

• FE (Medication administration) 

•  IU (Prescription and administration in emergency) 

• RA (Therapeutic drug substitution) 

• AD (Modification of drug therapy) 

• PH (Post-hospitalization care management) 

• DC (Request for consultation addressed to pharmacist) 

• W (Anti-coagulation therapy) 

• W1 (Deprescription service) 

• W2 (Dose adjustments) 
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• Z (Evaluation service for prescription extension 

•  SP (Palliative care) 

• V (Prescribing drug or initiating therapy) 

When these service codes are used without an appropriate prescription type designation, a You must specify 
Written, Faxed or e-Rx for this drug error appears, preventing claim submission until the requirement is satisfied.  

 

This validation operates independently of drug card configuration settings, applying at the service code level rather 

than the product level. When service codes other than those listed are used, the existing drug card-based 

Oral/Written validation behavior is maintained.   
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This implementation ensures compliance with RAMQ requirements that these service codes represent new 

prescriptions requiring written authorization and are not eligible for oral prescription or refill processing. 

[KRL-20486] RAMQ Service Code IU Automatic Assignment for Emergency Medication 

Administration 

Feature 

The system now supports automated service code assignment for RAMQ service code IU (Prescription and 
administration of a medication in an emergency situation) when emergency medication administration is initiated 

through the immunization module.  

When a prescription is triggered from the Add Epi shot right-click action in the Immunizations screen of the patient 

profile, the prescription screen is automatically populated with service code IU, service type A, and special program 

code 07 upon completion of the immunization module workflow.  

 

The prescription screen is pre-filled with patient information, prescriber (pharmacist) designation, and drug details, 

streamlining the emergency medication process. If a drug card contains service code configuration, the drug card 

settings take precedence over automatic assignment.  
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When service code IU is applied through drug card configuration or manual entry in the Plan Information screen, 

special program code 07 is automatically assigned if the special plan code field is not in override mode.  

Service type validation enforces the requirement for type specification, presenting an error when service code IU is 

used without a type designation.  

English error French error 
Service Code IU requires service type for Plan RAMQ La RAMQ exige un type de service pour le code de 

service IU 

Prescription type validation requires Written, Faxed, or e-Rx designation in the Oral/Written field, presenting the 

error You must specify Written, Faxed or e-Rx for this drug when other selections are made.  

Users retain the ability to override service code, service type, and special program code assignments as needed for 

specific clinical scenarios. This functionality requires the Enable Electronic Immunizations checkbox to be enabled in 

Store Config > Rx > Immunization settings. 

[KRL-20487] RAMQ Packaging and Transportation Billing Modules for Emergency and Exceptional 

Circumstances 

Feature 

Dedicated billing modules are now provided for RAMQ service codes 7 (Emergency or exceptional transport costs) 

and 8 (Packaging charges for transport), enabling streamlined claim submission for packaging and transportation 

services linked to existing prescriptions.  

Two new extra functions are available from the Patient Profile prescription list for Quebec stores:  

English  French  
Claim Packaging Facturer un emballage 
Claim Transportation Facturer un transport 

Both are accessible through both right-click context menu and the Extra Functions combo box under a new 

Packaging and Transport (French: "Emballage et transport") submenu. These functions are available only for mixture 

prescriptions that are not in Dropoff, Clinical verification, Unfilled, Non-dispensed, Expired, or Stopped status.  
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When Claim Packaging is selected, the system navigates directly to a pre-filled prescription screen with service code 

8, automatically populating the pharmacist as prescriber and displaying a comment in the general comments section.  

English comment French comment 
Packaging fee for RxNum: [prescription rxnum] Frais d'emballage pour la RX [prescription rxnum] 

The system searches for DIN 00989002 (Packaging charges for transport) and applies the drug card if exactly one 

match is found.  

When Claim Transportation is selected, the system presents a new Rx Transportation module (French: "Transport 

de Rx") containing read-only prescription tracking information including RxNum, patient details, drug information, and 

refills remaining (labeled "Renouv." in French), along with editable fields for transportation cost and intervention code 

selection. The Transportation Details section requires users to enter a transportation cost (validated to be greater 
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than $0) and select an intervention code before the Finalize button becomes enabled. Upon finalization, the system 

creates a to-do item, stores the prescription number, remaining refills, fee amount, and intervention code, then 

navigates to a pre-filled prescription screen with service code 7 and DIN 00989004 (Emergency or exceptional 
transport costs).  

Both modules transmit the linked prescription's RxNum in the NoOrdnc field of RAMQ claim requests while sending 

zero as the DIN, enabling RAMQ to associate packaging and transportation charges with the original prescription. The 

system validates that service codes 7 and 8 originate from their respective modules, presenting errors  when these 

codes are applied through other means: 

English error French error 
Not from Transportation Module Ne provient pas du module Transport 
Not from Packaging Module Ne provient pas du module Emballage 

Intervention code validation for service code 7 displays a warning when no intervention code is provided, though 
users may proceed with submission as RAMQ performs final validation. 

English warning French warning 
Service Code 7 requires an intervention code for Plan 
RAMQ 

Le code de service 7 requiert un code d'intervention 
pour RAMQ 

[KRL-20840] Modification of a Drug Therapy (AD) 

Feature 

The system now supports billing for the modification of drug therapy using the Adaptation Module with service code 

AD in compliance with RAMQ regulations.  

When processing an AD service code, the system automatically defaults the fee amount based on the number of 

times the AD service code has been billed for the patient during the current calendar day. The system performs 

validation checks to ensure an intervention code is present when required and verifies that the prescription nature is 

set to Written, Faxed, or e-Rx. Users receive appropriate warnings when attempting to bill AD more than four times in 

a single day, as RAMQ will reject fifth and subsequent claims for the calendar day. 

[KRL-20976] ] Extend Pricing strategy logic to support formulary determination for federal plans in 

Quebec 

Feature 

The system now evaluates formulary status for drugs under federal plans (RCMP, VET, NIHB, DND, IFHP) in Quebec-

configured instances. When processing transactions with federal plan coverage, Kroll determines if a drug is 

formulary by verifying that the drug card is covered by a RAMQ plan and includes a value in the usercost2 variable 
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(RAMQ BAP). Based on this formulary determination, the system applies the appropriate pricing strategy configured 

in the federal plan for either formulary or non-formulary drugs.  

This functionality enables consistent pricing strategy application across both RAMQ and federal plans while 

maintaining existing RAMQ formulary determination logic without modification. 

[KRL-22151] Allow user to push addition Pill Pack fee to patient for service code G 

Feature 

Kroll can now bill patients for supplementary unit dose fees when processing RAMQ prescriptions using Service 

Code G (pill pack service code for patients ineligible under Rule 24).  

The system now evaluates unit dose patient price group strategies configured with markup values and applies these 

additional fees on top of the standard RAMQ base fee calculation. When a patient has a unit dose price group 

assigned and the prescription is processed with unit dose enabled and RAMQ Service Code G, Kroll calculates the 

combined fee (RAMQ base fee plus the configured markup) and submits this total to RAMQ for adjudication. 

Following adjudication, the remaining fee amount, combined with any drug costs not covered by RAMQ, is presented 
to the user as the patient-billable amount.  

This functionality operates exclusively for RAMQ Service Code G and does not apply to Service Code P or other 

RAMQ service codes. The unit dose price group strategy supplements rather than replaces the RAMQ plan pricing 

strategy, adding only the markup value to the fee calculation. This enhancement enables pharmacies to recover 

additional unit dose preparation costs from patients who are not eligible for full RAMQ coverage under pill pack 

regulations while maintaining compliance with RAMQ billing requirements. 

Rx Number 

[KRL-19813] Changing a regular Rx number to a Narcotic Rx number when a Narcotic drug is filled 

Feature 

When a user tries to change a regular prescription number to a narcotic prescription number or vice versa , an error 

message now appears in both Refill and Modify modes.  
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RxConsult 

RxConsult is a chargeable module. Contact your TELUS sales representative for more information. 

[KRL-10004] Integrate Follow-ups entered in RxConsult and automatically add to Kroll after service 

finalized 

Feature 

Stores using Minor Ailments have always added follow-ups via the Professional Service view after completing the 

assessment via RxConsult.  RxConsult actually supports the ability to enter a follow-up in their system.  However, Kroll 

was never integrated with that part of their web utility. This has been changed. 

Kroll is now integrated with the Follow-up logic contained in RxConsult. This means that the user can now enter the 

follow-up while doing the assessment in their web utility, and when the user is returned to Kroll, a follow-up record will 

automatically be created and associated to the minor ailment professional services record. 

To support this properly in Kroll, the Follow-Up screen for all Professional Service records (aka Patient Encounters) 

has been modernized including: 

• General Counseling 

• Medication Reviews 
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• Professional Notes 

• Minor Ailments 

• Rx Adaptations 

• Rx Extensions 

The Follow-up options have been consolidated into a drop down, where a new Follow-up at any time option has 

been added. This option supports the way follow-ups are completed in RxConsult. The Follow-Up Due Date will not 

display if this method is selected (as the follow-up does not have an inherent date associated to it).  

When you enter in a follow-up in RxConsult, it will automatically create the follow-up in Kroll. You can create multiple 
follow-ups in RxConsult, which will create the same number of records in Kroll. 

You can still manually create follow-ups in Kroll.  

[KRL-15624]  Map Quebec-specific billing codes to FFS claims in Kroll when output message received 

from RxConsult 

Feature 

New logic was added to the system to automatically populate the Rx Plan Information screen with details received 

from Vigilance's RxConsult engine when the user in Kroll has initiated a minor ailment assessment/pharmacist service 

from the Professional Services module in the patient card. 

This change is specific for Quebec, as mapping has already occurred for the other provinces. Quebec uses a different 

set of codes, so now that Kroll is launching this utility in Quebec, these mapping changes need to occur. 

Once the user has completed the assessment in RxConsult, the message sent back to the pharmacy will contain the 

proper codes and details needed to be sent to the provincial plan/ These will automatically be included when 

submitting the claim for reimbursement, without requiring the user to add these details manually. 

[KRL-15710] Update Rx Adaptations to integrate with RxConsult in Quebec 

Feature 

Kroll now integrates with RxConsult for prescription adaptations in Quebec. When enabled, you can record 

prescription adaptations directly in the RxConsult web interface instead of using Kroll's built-in adaptation screen. 

To enable, our store must be configured for Minor Ailments (File > Configuration > Kroll > Modules) and set to 

Quebec province (File > Configuration > Kroll > General).  Go to File > Configuration > Store > Patient > 

Professional Services and set Rx Adaptation to RxConsultAction.  
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To start an adaptation do either of the following:  

• From a patient's prescription profile, right-click on the prescription and select Adapt Rx by Pharmacist 

• From Prescription Filling (F12), select Adapt Rx 

In RxConsult: 

1. Select the type of adaptation:  

• Adjust Dose 

• Modify Pharmacotherapy 

• Substitute Medication 

• Deprescribing 

2. Answer the guided questions. 

3. Use Re-prescribe to make changes to the prescription. 

4. Press F2 to update who provided consent. 

5. Complete the assessment. 
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You are returned to Kroll automatically. 

6. Back in Kroll, submit the Fee for Service claim (automatically created in your To Do queue). 

7. Fill the adapted prescription (automatically created in your To Do queue). 

All documentation from RxConsult is saved to the Professional Services record 

[KRL-15742 ] Update Rx Extensions to integrate with RxConsult in Quebec 

Feature 

Kroll now integrates with RxConsult for prescription extensions in Quebec. When enabled, you can record 
prescription extensions directly in the RxConsult web interface instead of using Kroll's built-in extension screen. 

Your store administrator can enable this feature: 

1. Go to File > Configuration > Store > Patient > Professional Services. 

2. Set Rx Extension to RxConsultAction. 

Note: Your store must be configured for Minor Ailments and set to Quebec province. 

To start an Extension: 

1. From a patient's prescription profile, right-click on the prescription and select Extend Rx by Pharmacist.  
2. In RxConsult, select Renewal. 
3. Answer the guided questions. 

4. Use Re-prescribe to make changes to the prescription. 

5. Press F2 to update who provided consent. 

6. Complete the assessment. 

You'll be returned to Kroll automatically. 

7. Submit the Fee for Service claim (automatically created in your To Do queue). 

8. Fill the extended prescription (automatically created in your To Do queue). 

All documentation from RxConsult is saved to the Professional Services record. 

[KRL-15764] Update laboratory analysis to integrate with RxConsult in Quebec 

Feature 

Kroll now integrates with RxConsult for prescribing and updating lab tests in Quebec (called Laboratory Analysis). 

When enabled, you can record lab requests and results directly in the RxConsult web interface instead of using Kroll's 

built-in screens. 

Your store administrator can enable this feature: 

1. Go to File > Configuration > Store > Patient > Professional Services. 
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2. Set Laboratory Analysis to RxConsultAction. 

Note: Your store must be configured for Minor Ailments and set to Quebec province. 

To start a Lab request/update: 

1. From a patient's Patient Encounter view, select: All Patient Encounters → INS → Laboratory Analysis. 

2. In RxConsult , Select Lab prescribe/Lab record.  

3. Answer the guided questions.  

4. Complete the assessment.  

You'll be returned to Kroll automatically. All documentation from RxConsult is saved to the Professional Services 

record. 

[KRL-15784] Properly support languages for Patient sheets and content generated by RxConsult 

Feature 

There was an issue when sending language settings to RxConsult when performing Minor Ailments and related 

services.  RxConsult is able to produce content that is intended for both the store and for the patient. In the message 

documentation returned, these are supposed to appear in the language of either the user's running session, or the 

patient's preferred language.  The problem is that when Kroll sends the initial message to RxConsult, it is using only 

the user's session language setting to populate the store's preferred language. It is not populating either the patient’s 

preferred language.  This is wrong. 

Please note, that for providers, Kroll will also send the Preferred language selected in the doctor record, but Vigilance 

will still only return any physician-facing document in the language of the user session. This is beyond the control of 

Kroll. 

The system will continue to send the user session's language in the correct place, but for the patient and provider 

portion of the message, the actual preferred language of the both will now be sent instead. This means that RxConsult 

will return proper documentation based on the language of the selected recipient. 

Note: RxConsult only supports two patient-specific languages: 

• English 

• French 

Kroll is able to support the above two patient languages properly.  For patient languages in Kroll not supported by 
RxConsult, the message will default to the store's database language instead. 
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[KRL-15891] Update KCM to include AQPP Laboratory Analysis as a fee for service on the drug card 

Feature 

A new AQPP Laboratory Anaylsis Fee For service type has been added to the drug card when entering a Fee For 

Service record: 

This type can be used in the province of Quebec when submitting a lab requisition fee to the private payor AQPP (if 

supported for that type of request). 

KCM has been altered to reflect this additional option when setting up drug cards by a system administrator. 

[KRL-16740] Force follow-ups in RxConsult for Minor Ailments, Adaptations, Extensions, and Lab 

Analysis 

Feature 

Several new configuration options have been added to the Professional Services Configuration screen to control 

whether or not follow-ups are required when a user at the pharmacy is accessing RxConsult (aka Minor Ailments). The 
following options have been added: 

• A specific option for Minor Ailments. This option applies to all provinces, including Quebec 

• Options for three modules in Kroll that can be configured to be used in the province of Quebec and only if 

RxConsult has been enabled for that store: 

• Adaptations 

• Extensions 

• Laboratory Analysis 

When enabled, the user must complete at least one follow-up prior to completing the assessment in RxConsult. 

[KRL-16825] Add Patient Configuration options to support Professional Services modules for 

RxConsult in Quebec 

Feature 

RxConsult has been integrated with Kroll in Quebec. You can now configure the following three modules in Kroll: 

• Adapt a prescription - Change the dispensing of a prescription based on what the provider originally ordered 

• Extend a prescription - Renew a prescription in situations where authorization from the provider cannot wait 
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• Laboratory Analysis - Create a Lab Requisition and record results later - This is strictly used in Quebec only 

All of the Professional Services options have been removed from the Rx > Counseling screen. A new Professional 
Services sub-tab screen has been added to the Patient screen. All of the fields that were on the Counseling 
Configuration screen are now on the new tab.  

A new Module section has three menus to support the ability to indicate if the system should use the regular 

functionality in Kroll versus RxConsult.  

• Adaption 

• Extension 

• Laboratory Analysis 

 

RxConsultAction is only a viable choice if the system is enabled for Minor Ailments and set to the province of 

Quebec. 

If any of these modules are set to RxConsultAction and Minor Ailments is disabled in Kroll Configuration, then they 
will be automatically reset to their default settings. 

[KRL-16860] Add Immunization Configuration option for RxConsult in Quebec 

Feature 

RxConsult has been integrated with Kroll in Quebec. You can now configure the Immunization module in Kroll: 

To accommodate this change, the Enable electronic immunizations checkbox has been removed from the File > 

Configuration > Store > Rx > 8 – Immunization screen. 

A new Module dropdown indicates which type of Immunization module the store opts to use: 

• Paper - The system will revert to the basic Immunization logic where a paper must be printed out to ask all 

questions and then scanned back in 
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• Electronic - The system will use the existing logic where the immunization questionnaire is within Kroll itself 

(former functionality of the Enable electronic immunizations checkbox) 

• RxConsultAction - The system will interact with Vigilance's RxConsult web engine when performing an 

immunization 

 

RxConsultAction is only a viable choice if the system is enabled for Minor Ailments and set to the province of 

Quebec. Note: This option may appear in 10.35, but it will not be functional until the next release (10.36).  

If the Immunization module is set to RxConsultAction, but Minor Ailments is disabled at that store, then the system 

will automatically set the above option back to the initial default (i.e. Paper). 

 [KRL-20956] Allow new medication to be entered in RxConsult for Adaptations 

Feature  

Users of Kroll in Quebec can adapt prescriptions using an integration with Vigilance’s RxConsultAction. Adaptations 

are always started in Kroll using an existing prescription.  

When in the RxConsultAction web utility, the user can manually enter in a new medication to adapt. Then when the 

store receives the message from RxConsultAction, the reference to the original prescription is gone. A new “unfilled” 

inactivated prescription is not created in Kroll to reference to the new prescription.  
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To help solve this, an Rx Comment will be added to the new prescription that the original Rx was adapted to. This 

comment will only appear in the case where the use originated the adaptation in Kroll, and then unchecked that 

medication in RxConsultAction, and then manually entered in a medication in that utility. 

As a best practice in Quebec, users should always adapt the medication that they started from in Kroll, and to not 

change or add new medications while adapting that prescription in RxConsultAction. 

RxSync Consent 

The following consent options are only visible to pharmacies who have purchased the Enhanced RxSync module. 

Contact your TELUS sales representative for more information. 

 [KRL-16712] RxSync Consent Configurations  

Feature 

New configuration options are now available in File > Configuration > Store > Rx > RxSync tab to help you manage 

patient consent requirements for Enhanced RxSync.  

 

Options are:  

• Require Consent for Enhanced RxSync - Choose whether patients must provide actual consent before using 
RxSync.  

• Enable Consent Expiration - Set whether consent expires automatically over time  

• Consent Validity Duration - Choose how long consent remains valid (12, 18, or 24 months)  

Your settings will automatically start with defaults based on your province:  
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• Ontario: Consent required by default  

• Quebec: Consent expiration enabled (12 months) by default  

• Other provinces: No consent requirements by default  

Note: You can customize any of these settings regardless of your province.  

Changes take effect immediately - no restart required.  

 [KRL-18427] Update Patient Consent report to include Enhanced RxSync consent records 

Feature 

The following report option is only visible to pharmacies who have purchased the Enhanced RxSync module. Contact 

your TELUS sales representative for more information. 

You can now generate Patient Consent reports filtered specifically for Enhanced RxSync Consent records, giving you 

better visibility into patient consent data for the Enhanced RxSync program. Data in each record includes patient 

name, consent status, date, and comments. The report supports both patient-signed and agent-signed (on behalf of 

dependent) consent scenarios.  

To generate a Patient Consent report:  

1. Navigate to Reports > Patient > Patient Consent Report.  

2. On the Selection 2 tab, select Enhanced RxSync Consent from the Consent Type dropdown.   

3. Choose your desired consent statuses (Verbal Consent, Written Consent, No Consent, etc.)  

4. (Optional) Toggle Include revoked and Include expired checkboxes to include or exclude these records.  

5. Run the report as usual.   

Note: This feature is only available when Enhanced RxSync is enabled in your Kroll configuration. 

[KRL-18429] Add New Enhanced RxSync Consent type 

The following consent options are only visible to pharmacies who have purchased the Enhanced RxSync module. 

Contact your TELUS sales representative for more information. 

Feature 

Implemented EnhancedRxSyncConsent type with enhanced modes, including revocation, and expiry workflows. 
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[KRL-18431] Integrate RxSync Consent with Document and Network Scan Queues 

Feature 

Users can now scan and attach signed Enhanced RxSync Consent forms directly through the Document Scan and 

Network Scan queues, streamlining the process of associating paper consent forms with digital patient records.  

You can print Enhanced RxSync Consent forms with embedded 2D barcodes that automatically link scanned 

documents to the correct patient and consent record.  

Auto-Complete Workflow: When a valid barcode is scanned back in, the system automatically links it to the patient 

record and associates it with the correct Enhanced RxSync Consent record. The consent status is updated to 

Completed and the patient’s information (name, address, DOB) is populated. Consent details (type, status, date) are 

displayed.  

Manual Processing Option: If a barcode is missing or unreadable, you  can manually search and select the patient 

(F3), then choose from pending Enhanced RxSync Consent records and review and confirm consent details before 

processing.  

Document Management  

• Non-PDF scans (JPEG, TIFF) are automatically converted to PDF format  

• Attached consent documents are locked and cannot be deleted, protecting signed legal documents  

• Users can preview and reprint signed forms at any time  

Workflow Enhancements  

• Only pending (not completed, revoked, or expired) consents appear in the selector  

• Users must confirm consent response before processing if status is Unknown. 

• Process completion via Process Pending Documents (Document Scan) or Save (Network Scan)  

To use this feature, the store must be configured for Enhanced Consent (File > Configuration > Store > Rx > 

RxSync) and Document or Network scanning.  

 [KRL-18723] Create RxSync Consent Questionnaire Schema (Default KCM Version) 

Feature  

Added Schema document for Enhanced RxSync Consent.  
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Provinces 

Quebec 

[KRL-20916] Kroll properly supports Management Stopped for prescription adaptations in Quebec 

Improvement 

Kroll has been enhanced to properly handle prescription adaptations in Quebec when management of a medication is 

stopped through the Kroll Rx Adaptation feature. Previously, when performing any adaptation, the system would 

create an inactive prescription linked to a new prescription. For "Management Stopped" scenarios, this behavior was 

inappropriate as no new prescription should be created.  

The system now recognizes when a prescription adaptation results in stopping management of a medication and 

responds accordingly. When the user selects the Management Stopped option on the Rx Adaptation screen, the 

system disables the adapted prescription information fields at the bottom of the screen and suppresses data 

validation warning messages for required fields such as Doctor, Dispense Quantity, Days Supply, and Directions.  

Upon finalizing the adaptation, the system leaves the referenced prescription active with no status changes, creates 

the Professional Services record with Completed status, generates a To Do record for the Fee For Service claim 

when applicable, and does not create a new To Do record for a new prescription or prompt the user to dispense a 

prescription. This ensures proper workflow handling when medication management is discontinued rather than 

modified through the adaptation process. 

Saskatchewan 

[KRL-18132] Implement selecting a Pharmacist Prescribe Reason for Regular, Compound, and Unfill 

Rxs that are part of a Batch filling process 

Improvement 

When copying a prescription for a compound or a regular drug to a new number and making it unfilled then adding 

the pharmacist as the doctor,  claims were being rejected on the batch process form because no pharmacist 

prescribe reason was added.  

The process has been updated. Now, if no pharmacist prescribe reason has been provided, a validate message 

appears:  

You must specify a pharmacist prescribe reason. 

The user must add the pharmacist prescribe reason to proceed. The Rx completes successfully.  
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